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Conformational Analysis with Spartan Model (aka “SpModel”)1 
 
The activities described on the following pages show you how to perform a complete conformational analysis 
of three different molecules. They are interesting in their own right, but, taken collectively, they demonstrate 
all of the operations needed to analyze the conformational preferences of cis and trans-3,3,5-
trimethylcyclohexanol, the two alcohols that you have prepared and characterized in lab. Please refer to these 
instructions when you undertake the conformational analysis of these alcohols and prepare your lab report. 
 
Conformational analysis by computer? Our usual method for performing a conformational analysis is to 
imagine or draw all of the important conformers of a molecule and identify the most stable one(s). How can a 
computer help? Why might a computer even prove necessary at times? 
 
The first answer to these questions is a computer can juggle more interactions than our minds can. The more 
complexity we see in a molecular structure, the more likely we are to throw up our hands and say, “ask the 
computer.” Second, a computer can give quantitative estimates of conformer energy, and these can be used 
to calculate equilibrium constants and concentrations. 
 
Caution. SpModel (and especially Sp08) contain a large number of useful tools for making models. Choosing 
the wrong tool is not really a “mistake”, but it might lead to an incredibly time-consuming (and possibly 
useless) calculation. Read each instruction carefully before you perform each step. 
 
Overview. The activities covered here include: 
 

1. Building anti 1-bromopropane. Optimizing its geometry and measuring bond angles and distances. 
 
2. Building gauche 1-bromopropane using internal rotation. Optimizing its geometry and using the anti 

and gauche energies to calculate Keq for the anti-gauche conformer equilibrium. 
 
3. Building and optimizing trans-1-ethyl-3-methylcyclohexane conformers. Calculating Keq for the 

conformational equilibrium. Repeating the same steps for trans-2-ethyl-6-methylcyclohexanone. 
 
 
Spartan Model activity #1 
 
 

 Click with the left mouse button (unless told otherwise). 
 
 Start SpModel by double-clicking on its desktop icon (or select from Start: All Programs menu). 
 

 Maximize the program window by clicking on the Maximize button  in the upper right corner. 
 
 
Build a model of 1-bromopropane, CH3CH2CH2Br 

 

Br
C

C
C

1-bromopropane

H are not shown
anti conformer

 
 

 Click on the New icon . This replaces the “view” window with the “build” window (the build 

window contains an atom “palette” on the right side) and it selects the Add icon . 

                                                      
1 All of these activities can also be carried out using Spartan’08 (aka Sp08). We prefer that you use SpModel because it has a simpler 
interface. 
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 If necessary, click on the sp3 hybridized C atom in the palette , then click somewhere in the 
green window. This places one carbon atom plus four yellow “free valences” in the window. The free 
valences are used to add more atoms to the model. If they are not used, they will automatically 
change into hydrogens, so this structure can also be regarded as a model of methane, CH4. 

 
 Add a second carbon by clicking on the tip of a free valence. Repeat this to add a third carbon. You 

should have a three-carbon model at this point. 
 

 Add bromine by clicking on the Br atom in the palette , then click on the tip of the anti free 
valence of an end carbon so that your model has an anti conformation (see drawing on pg. 1). 

 

 When you finish building, click on the View icon  to return to the “view” window. 
 

 Correcting mistakes. 
 

o Select Undo from the Edit menu. This will usually undo the most recent operation. 
 

o Click on the Delete icon , then click on the atom(s) that offend you. When you are 

finished making corrections, click on  to return to the “build” window, or click on  to 
return to the “view” window. 

 
o Select Clear from the Edit menu. This makes the entire model vanish. 

 
 Moving your model. Try these operations: 

 
o Rotate. Press left mouse button and move mouse. 
 
o Translate. Press right mouse button and move mouse. 
 
o Grow/Shrink. Press Shift key and right mouse button simultaneously, and move the cursor 

up and down on the screen 
 
 
Measure some bond distances and bond angles 
 
Whenever you build a model, SpModel uses a table of standard bond distances and bond angles to position 
the atoms. This “initial” geometry is a reasonable guess as to what your molecule looks like, but it is probably 
not too reliable because complicated molecules are usually affected by factors (steric repulsion, electrostatic 
interactions, electron delocalization, and so on) not found in “standard” molecules. You can easily 
demonstrate the “complicated” nature of 1-bromopropane for yourself: 
 

 Click on the Distance icon . Notice the Distance(,) label that appears in the lower right corner. 
 
 Click on a pair of neighboring C atoms. The atoms turn gold as you click on them (they are “selected”) 

and the distance between them (in Å) appears in the lower right corner. 
 

o Short-cut: You can also get a bond distance by clicking on a bond. The bond will turn gold 
when it is selected. 

 
o Hint: You can unselect any item by clicking on it a second time. 
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 Record the C1-C22 and C2-C3 bond distances in the following table under “Initial geometry”. 
 

 Click on the Angle icon . Notice the Angle(,,) label that appears in the lower right corner. 
 
 Click on C3, then C2, and then C1 (in this order). The atoms turn gold and the CCC bond angle (in o) 

appears in the lower right corner. Record the CCC bond angle under “Initial geometry”. 
 

 Click on Br, C1, and C2 (in this order) and record the BrCC bond angle under “Initial geometry”. 
 

 How do the geometrical parameters listed under “initial geometry” indicate that the model is based on 
“standard” distances and angles? 

 
 Initial geometry Optimized anti geometry Optimized gauche 

geometry 
C1-C2 bond distance    
C2-C3 bond distance    

CCC bond angle    
BrCC bond angle    

strain energy    
 
 

Optimize your model’s geometry using the Minimize icon , (molecular mechanics) 
 
“Optimization” (aka “geometry optimization”, “minimization”, and “energy minimization”) is a procedure that 
uses energy calculations to obtain more accurate molecular geometries. The idea behind optimization is 
simple: the model’s geometry is changed incrementally by adjusting the position of each atom, then the 
model’s energy is calculated at the new geometry. The “adjust/calculate” cycle is repeated until a minimum-
energy, or optimized, geometry is discovered. The result, an “optimized” model, has a lower energy than any 
model with a similar geometry. 
 
As you might expect, optimization works only if the computer has a reliable method for calculating the energy. 
At the very least, an energy calculation should take into account interactions that a “standard” molecule might 
lack: steric repulsion, electrostatic interactions, long-range resonance, and so on. Unfortunately, no method 
for calculating energy is ever completely satisfactory. One method might estimate steric repulsions incorrectly, 
while another might have difficulties with electrostatic interactions. These are just models, after all, but they 
are usually more accurate than the “standard” geometry that we start with. 
 

One way to optimize a model’s geometry is to click on the Minimize icon . This option is useful for our 
purposes because 1) it is simple and fast, and 2) it relies on an energy calculation called “molecular 
mechanics” that is able to simulate steric interactions and modest electrostatic interactions, such as dipole-
dipole interactions. Molecular mechanics calculations yield a sort of strain energy for the model so the 
minimum-energy geometry is the one that is least strained. 
 

 Click on the minimize icon . The model’s bond distances and angles are adjusted to give an 
optimized geometry. The strain energy of this model (in kJ/mol or kcal/mol) is shown in the lower right 
corner. Record this energy (and the units) in the table shown above in the “Optimized anti geometry” 
column. If you followed all of the directions correctly, your model’s strain energy will be –8.96 kJ/mol 
(or –2.14 kcal/mol). 

 

                                                      
2 Atom numbers are derived from the IUPAC name. C1 is the carbon  bonded to bromine, C2 is the adjacent carbon, and so on. 
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Molecular mechanics optimizations are normally blazingly fast, especially for small molecules. However, you 
can monitor an optimization’s progress by looking at the “stop sign” in the lower right corner. Red means “still 
working”; gray means “finished”. You can stop an optimization in the middle by clicking on the red stop sign. 

 
 Re-measure your model’s bond distances and bond angles and enter your data in the “Optimized anti 

geometry” column of the table on the previous page. The distances and angles should have changed 
slightly. Notice that optimization makes the CC bond distances different from each other and it makes 
the bond angles different from each other. These differences occur because atoms always adjust 
their positions to reflect the unique combination of interactions found in a given molecule. 
Optimization is an essential step in constructing molecular models. 

 
 
Spartan Model activity #2 
 
This activity shows you how to use internal rotation to convert anti into gauche 1-bromopropane. After that, 
you will optimize the gauche geometry and compare it to the anti geometry. 
 
 
Use internal rotation to change conformation 
 

 Click on the Add icon . 
 

 Click on the C1-C2 bond to make it “active” (a small-red arrow encircles an “active” bond). 
 
 Rotate the model (left mouse button) so that C1 is hidden behind C2 (you want the model to look like 

a Newman projection). 
 

 Press the Alt key and the left mouse button simultaneously, and move the cursor up and down on the 
screen until Br and C3 are gauche. 

 

Optimize your model’s geometry using the “minimize” icon  
 

 Click on the minimize icon . Record your model’s strain energy in the “Optimized gauche 
geometry” column of the table in Activity #1. If you followed all of the directions correctly, your model’s 
strain energy will be –7.35 kJ/mol (or –1.76 kcal/mol). 

 
It might surprise you that “minimization” leads to a gauche structure and not the more stable anti structure. 
Recall that minimization relies on consecutive “adjust/calculate” cycles. Adjustments are restricted in 
magnitude so that each new model resembles the one that preceded it. This restriction also guarantees that 
minimization will yield the minimum-energy structure closest to the starting structure, the so-called “local” 
minimum. To find the very best structure for a molecule, the “global” minimum, one needs an “adjust” strategy 
that moves atoms larger distances. 
 
 
Use relative strain energies to calculate a conformational equilibrium 
 
Your calculations should show that the anti conformer is more stable (less strained) than the gauche 
conformer by 1.61 kJ/mol (0.38 kcal/mol). Now, we would like you to compute the equilibrium ratio of the anti 
and gauche conformers. This ratio depends on their relative free energies, 
 

[anti]eq / [gauche]eq = Keq = 10–G/2.3RT
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and free energy differences are not the same as strain energy differences. Free energy differences depend 
on enthalpy, entropy, and temperature: 


G =H – TS 

 
Combining formulas gives us: 
 

Keq = 10– (H – TS)/2.3RT 
 

= ( 10–H/2.3RT )( 10TS/2.3RT ) 
 

= ( 10–H/2.3RT )( 10S/2.3R ) 
 
Obviously, we need enthalpy, entropy, and temperature data if we want to calculate equilibrium 
concentrations. 
 
The calculated difference in strain energies can be equated with the enthalpy change, H. This value is 1.61 
kJ/mol (0.38 kcal/mol) for anti  gauche 1-bromopropane. The other values that are needed are R = 8.31 
J/mol K (= 1.98 cal/mol K) and T = 298 K. Combining these values gives us: 
 

Keq = ( 10–H/2.3RT )( 10S/2.3R ) = 1.90 (10S/2.3R ) 
 

Rather than have you calculate S, we will simply point out that the entire entropy term, 10S/2.3R, is roughly 
equal to the statistical ratio of conformers, (#anti)/(#gauche), where #anti and #gauche are the number of 
independent, equivalent forms of each conformer. To determine these values, we ask “how many equivalent 
ways can we draw or build each conformer?” The anti form can only be built (or drawn) in only one way,3 but 
there are two mirror-image gauche conformers, so (#anti)/(#gauche) = 1/2. This leads to: 

 

Keq = 1.90 (10S/2.3R ) = ( 1.90 )( 1/2 ) 
 

[anti]eq / [gauche]eq = 0.95 
 

Even though the anti conformer is slightly more stable, we predict that there will be a tiny bit more gauche 
conformer at equilibrium at 298 K. 
 
 
Measure some bond distances and bond angles 
 

 Measure the appropriate bond distances and bond angles in gauche conformer, and record them in 
the “Optimized gauche geometry” column of the table on pg. 3. 

 
Compare the distances and angles for the optimized conformers. Based on these observations, can you 
suggest a hypothesis that would explain why the gauche conformer is more strained? (Hint: the gauche 
conformer contains larger bond angles. Which atoms, and what kind of interaction, are responsible for these 
larger bond angles?) 
 

 When you are finished, close all of the open models by selecting Close from the File menu (or click 

on the Close icon ) 
 
 
 
                                                      
3 If you also allow for internal rotation of the methyl group, there are three equivalent anti forms (# anti = 3), and six equivalent gauche 
forms (# gauche = 6), which still leads to (# anti)/(# gauche) = 1/2. 
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Spartan Model activity #3 
 
Geometry and energy are always closely connected, but while we can easily “see” geometry, energy must be 
inferred or calculated. Consider the two chair conformers of trans-1-ethyl-3-methylcyclohexane shown below. 
Neither conformer manages to get both substituents into the preferred equatorial positions. This makes the 
preferred geometry an open question. The following activity shows you how to resolve this matter by 
comparing strain energies. 
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Build and optimize “equatorial ethyl” trans-1-ethyl-3-methylcyclohexane 
 

 Click on the New icon . 
 
 Select Cyclohexane from the Rings menu, and click somewhere in the green window. 

 
 Add whatever atoms are necessary to make an axial methyl group and an equatorial ethyl group as 

shown above 
 

 Click on the Minimize button  and record the strain energy here: _________ 
 
Internal rotation about the ring-ethyl bond generates three different conformers. To find the preferred 
conformation of the “equatorial ethyl” conformer, we rotate the ethyl group into each staggered position and 
calculate the strain energy. 
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 Use internal rotation to move the ethyl group into another staggered “equatorial ethyl” conformer. 

Click on the Minimize button  and record the strain energy here: _________ 
 
 Repeat the above step to obtain the energy of the third “equatorial ethyl” conformer. Record the strain 

energy here: _________ 
 

 Compare the strain energies of the three “equatorial ethyl” conformers, and record the lowest strain 
energy in the table on pg. 7. 
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 strain energy (kcal/mol) 
trans-1-ethyl-3-methylcyclohexane 

strain energy (kcal/mol) 
trans-2-ethyl-6-methylcyclohexanone 

equatorial ethyl   
axial ethyl   

[eq Et]/[ax Et] @ 
298K 

  

 
 
Build and optimize “axial ethyl” trans-1-ethyl-3-methylcyclohexane 
 

 Use the same strategy to create and optimize three “axial ethyl” conformers. Record the lowest strain 
energy in the table. 

 
 Based on the energies in the table, which conformer is more stable, equatorial ethyl or axial ethyl? 

Why do you suppose this is? 
 

 Use the difference in conformer strain energies to calculate the equilibrium ratio of the equatorial ethyl 
and axial ethyl conformers.4 Record this ratio in the table. 

 
Chemists like to believe that the behavior of a complicated molecule can be predicted by making extrapolating 
from the behavior of simple molecules. We have seen that this is roughly true when it comes to bond 
distances and bond angles, but what about conformational preferences? For example, is the preferred 
conformation of trans-2-ethyl-6-methylcyclohexanone (“complicated molecule”) identical to the preferred 
conformation of trans-2-ethyl-6-methylcyclohexane (“simple molecule”)? 
 

CH2CH3H3C
H H

CH2CH3H3C

O

versus

 
 
Notice that the structural formulas look quite similar. Look again at the cyclohexane models you have just built 
and try to imagine, if you can, C=O in place of CH2. What would you predict about its conformational 
preferences? The same preferred conformation and a similar Keq? The same preferred conformation, but a 
substantially larger Keq? A change in the preferred conformation? Write down your prediction here: 
____________________________________________________________________________________ 
 
 
Build and optimize “equatorial ethyl” trans-2-ethyl-6-methylcyclohexanone 
 

 Rebuild “equatorial ethyl” 1-ethyl-3-methylcyclohexane model 
 

 If necessary, click on the Add icon  to open the “build” window 
 

 Click on the sp2 C hybridized atom in the palette , and then double-click on the C2 carbon atom. 
This replaces the two single bond free valences with one double bond free valence (see first step 
below): 

 

                                                      
4 You can ignore entropy changes for this calculation. 
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CH2CH3H3C CH2CH3H3C CH2CH3H3C

O

  
 

 Click on the double bond O atom in the palette  and single-click on the tip of the double-bond 
free valence. This creates a CO double bond and completes the desired model. 

 
 Use the procedure described above to optimize the model geometry, record the strain energy, and 

perform internal rotations on the equatorial ethyl group. Record the strain energy of the lowest energy 
conformer in the table. 

 
 
Build and optimize “axial ethyl” trans-2-ethyl-6-methylcyclohexanone 
 

 Repeat all of the building steps starting with “axial ethyl” trans-1-ethyl-3-methylcyclohexane and build 
the corresponding cyclohexanone. Use the same procedure to find the lowest energy conformer of 
“axial ethyl” trans-2-ethyl-6-methylcyclohexanone model and record this energy in the table 

 
 Based on the energies in the table, which conformer is more stable, equatorial ethyl or axial ethyl? 

Why do you suppose this is? (Look closely at your models for clues.) 
 

 Use the difference in conformer strain energies to calculate the equilibrium ratio of the equatorial ethyl 
and axial ethyl conformers.5 Record this ratio in the table. 

 
 
Questions for reflection 
 

 Why is optimization always necessary? 
 

 Are simple rules like “equatorial is preferred” always useful? 
 
 Are simple molecules necessarily a good guide to the geometries and energies of complicated 

molecules? 
 

 What aspects of a molecular formula ought to encourage you to make a model(s)? 
 

 
HOLD ON TO THESE INSTRUCTIONS 

 
(refer to them when modeling your alcohols and calculating Keq for your lab report)

                                                      
5 You can ignore entropy changes again. 


